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Read Me First 
Welcome to Take Control of Lightroom CC, version 1.1, published in 
February 2018 by alt concepts inc. This book was written by Jeff 
Carlson and edited by Kelly Turner. 

This book gives you all you need to know to use Lightroom CC, Adobe’s 
all-new desktop photo editor and organizer. Import, manage, and edit 
your photos, and understand where it fits in the Lightroom ecosystem 
(along with the updated Lightroom Classic CC). 

If you want to share this ebook with a friend, we ask that you do so 
as you would with a physical book: “lend” it for a quick look, but ask 
your friend to buy a copy for careful reading or reference. Discounted 
classroom and Mac user group copies are available. 

Copyright © 2018, Jeff Carlson. All rights reserved. 

Updates and More
 

You can access extras related to this ebook on the web (use the link 
in Ebook Extras, near the end; it’s available only to purchasers). On 
the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy 
any subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

•	 Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

If you bought this ebook from the Take Control website, it has been 
added to your account, where you can download it in other formats 
and access any future updates. However, if you bought this ebook 
elsewhere, you can add it to your account manually; see Ebook Extras. 
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What’s New in Version 1.1
 

Lightroom CC started off as a lean, cloud-centric cousin to Lightroom 
Classic CC, which means Adobe is being aggressive about adding 
features that didn’t show up in the initial 1.0 version. It’s a trend I hope 
continues as the software matures. 

This version of the book has been updated to reflect changes intro-
duced in Lightroom CC 1.1, released in December 2017, and Lightroom 
CC 1.2, released in February 2018: 

•	 For those who prefer curves to sliders when adjusting their photos’ 
tones, Adobe added the new Tone Curve tool. It’s a surprisingly 
powerful control within a compact interface. 

•	 When you want to add color to highlights and shadows, turn to the 
new Split Toning feature. 

•	 Lightroom CC now has the capability to view a photo fullscreen, 
without the application interface, something I do a lot when I’m 
looking over my edits. Press F in the Detail view. 

•	 The Manage Storage on Disk section has been reworked to reflect 
the refined approach Lightroom CC now takes, including the option 
to store a copy of all smart previews on your startup disk. 

•	 The Auto feature for automatically editing a photo now uses Sensei 
technology for improved results. I also added a sidebar about how 
Adobe uses your images to train its Sensei machine-learning 
service, and How to Opt Out of Sensei Analysis if you choose. 

•	 I accidentally omitted a section about applying titles, captions, and 
location data to your photos, which is now in Add Essential Infor-
mation. Adobe added the capability to adjust a photo’s time and 
date after the first revision of this book was released, so I’m going to 
pretend I was just waiting for that to appear. 
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Introduction 
This isn’t the Lightroom you think you know. And that’s okay. 

Introduced at the end of 2017, Lightroom CC is a brand new applica-
tion built around a cloud-centric workflow. As more and more of us 
access and edit photos on many different devices—laptops, desktops, 
tablets, and phones—we increasingly expect a seamless experience. 
This means having our images and edits show up on all our devices, 
immediately. 

The previous version of Lightroom, formerly called Lightroom CC but 
now named Lightroom Classic CC, wasn’t designed for that. It’s a 
desktop-centered application that was designed when the computer 
was the only place you’d import, manage, and edit your photos. Al-
though Lightroom Classic CC has adapted as best it can, Adobe decided 
a fresh alternative was in order. 

So now we have two Lightrooms, both being actively developed, and 
each with its own strengths. 

Lightroom CC is built on new code, engineered for cloud interaction, 
and meant to appeal to those who want to do more than the basics with 
their photos, but who are intimidated by Lightroom Classic CC and 
Photoshop. It’s designed to be a tool that’s inviting for anyone, regard-
less of skill level. It’s the Lightroom experience, streamlined and 
simplified (but not dumbed down). If this is your first experience with 
Lightroom, I think you’ll find Lightroom CC to be a great solution. 

Under normal circumstances, a book called Take Control of 
Lightroom CC would focus on the one application, but in this case, 
that’s not the whole picture. You may already have your photo library 
in Lightroom Classic CC and want to use Lightroom CC to explore this 
new direction and take advantage of the cloud-based architecture. 
Many of us who are already invested in Lightroom and Adobe’s ecosys-
tem want to find the best way to move forward—or sideways, with both 
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versions coexisting to take advantage of the strengths of each. So this 
book also looks at how the two programs work together. 

Lightroom CC runs on both Windows and macOS. Since I primarily 
work on a Mac, most of the screenshots throughout were taken under 
macOS; however, Lightroom CC is nearly identical under both. I call 
out differences where necessary. Oh, and to be clear—and avoid 
driving us both crazy—I refer to Lightroom Classic CC as just “Light-
room Classic” or “Classic” throughout (also, I don’t refer to Lightroom 
by its official name, Adobe Photoshop Lightroom Classic CC, because 
come on). 

7 

Click here to buy the full 142-page “Take Control of Lightroom CC” for only $14.99!

https://www.takecontrolbooks.com/cart?add-to-cart=1232


          
           
          

            
            

   

   
           

        
  

   
    

    

           
     

           
   

  
            

             
  

           
        

            
        

  

      
          

Lightroom CC Quick Start 
Importing your digital photos into Lightroom CC is the jumping-off 
point for editing, managing, and sharing the images. There’s no “right 
way” or linear path to working with them. I recommend you read 
through the first two chapters to get an overview of how the Lightroom 
ecosystem works and how to get photos into it, and then tackle which-
ever topic interests you. 

Get the big picture: 
•	 See how Lightroom CC and Lightroom Classic (as well as Lightroom 

Mobile and Lightroom for Web) work together as you Understand 
the Lightroom Ecosystem. 

Build your photo library: 
•	 Learn how to Import Photos from cameras, memory cards, and 

locations on your hard disk. 

•	 What about photos you capture using an iPhone or Android phone? 
You can Automatically Add Mobile Photos to Lightroom. 

•	 Understand how to Sync Photos, the key to taking advantage of 
Lightroom CC’s cloud-focused features. 

Organize your photos: 
•	 With just a little work managing your photo library, you’ll be able to 

track down good images and weed out the bad ones. See Rate and 
Tag Your Photos for easy steps you can take. 

•	 Don’t want to go to that trouble? Use Adobe Sensei technology to 
Find Your Photos, even if you’ve never touched keywords. 

•	 Lightroom CC handles all of your files behind the scenes, but there 
are some circumstances where you definitely want to Manage 
Storage on Disk. 

•	 And don’t forget to Back Up Your Library! (Spoiler: Having every-
thing in the cloud doesn’t automatically count as a good backup.) 
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Edit your photos: 
•	 Get a handle on the Essential Editing Basics, such as working in the 

Edit panel and copying and pasting adjustments between photos. 

•	 Recompose or re-orient a photo using Crop, Straighten, Rotate, and 
Flip. 

•	 Make your photos look their best when you learn to Adjust Lighting, 
Color, and Appearance. Did you find dust spots or visual distrac-
tions? Heal Areas and Remove Objects in your shots. 

•	 Use linear and radial gradients, and the Brush tool, to Adjust 
Specific Areas. 

•	 Save time and get a consistent look when you Apply Presets—or 
create your own. 

Share your photos: 
•	 Post images directly to your friends online when you Send to Face-

book, or Export to Disk when you want to share them elsewhere. 

•	 When you Share via Lightroom for Web, you can make an entire 
album public for people to view and, optionally, to download. 

Work with Lightroom Classic CC: 
•	 If you’re ready to go all-in with Lightroom CC, learn how to Migrate 

a Classic Catalog. 

•	 Or, if you want to continue using Lightroom Classic alongside Light-
room CC, discover what’s involved in running The Two-Lightroom 
Strategy. 

9 

Click here to buy the full 142-page “Take Control of Lightroom CC” for only $14.99!

https://www.takecontrolbooks.com/cart?add-to-cart=1232


 

            
            

         
    

          
     

         
            

        
        

           
   

          
          

            
         

      

      
         

          
        

            
     

         
          

            
      

Understand the Lightroom 
Ecosystem 

A decade ago, the original Lightroom started as a scrappy, upstart tool 
for handling image files captured in cameras’ raw formats. Today, it’s a 
collection of mature applications and platforms tied together by 
Adobe’s Creative Cloud network. 

With its October 2017 releases, Adobe switched around the names a 
bit, so here’s the new lineup: 

•	 Lightroom CC is the late-2017 version designed from scratch for 
the cloud. It copies all original image files to Creative Cloud and 
makes them available (either as originals or lower-resolution opti-
mized versions) to desktop or mobile devices running Lightroom 
apps. For easy identification in the Dock or Taskbar, its application 
icon has rounded corners. 

•	 Lightroom Classic CC is the latest version of the original Light-
room, formerly known as Lightroom CC. It boasts many features 
not (yet) found in the new Lightroom CC. It has the capability to 
sync collections (folders) to Creative Cloud, but uploads only Smart 
Previews. Its application icon has squared corners. 

•	 Lightroom CC for iOS and Lightroom CC for Android (often 
collectively referred to as “Lightroom Mobile”) are the versions that 
run on mobile phones and tablets. Lightroom Mobile has been 
designed to mirror Lightroom CC as much as possible, although 
they don’t share all of the same features (for example, the mobile 
apps don’t include a Healing brush). 

•	 Lightroom for Web is the Lightroom experience in a web brows-
er—no application needed. It’s not as full-featured as the desktop 
versions, but does more than you might expect. It’s also the easiest 
way to share groups of images with others. 
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Note: If you want to be pedantic, the real application names are 
Adobe Photoshop Lightroom CC and Adobe Photoshop Lightroom 
Classic CC. The mobile apps are called Lightroom CC. But I know you 
don’t want to be pedantic, so I’ll stick to Lightroom CC, Lightroom 
Classic, Lightroom Mobile, and Lightroom for Web. 

Jeff’s Migration Advice 
I want to offer some advice right at the beginning: if you’re already 
wedded to what is now Lightroom Classic CC, do not migrate your 
libraries to Lightroom CC. In Work with Lightroom Classic, I go into 
more detail on why, including how to work with both applications in 
tandem. For now, though, Lightroom CC isn’t ready to be a full 
replacement for Classic, and migrating your existing libraries could be 
thorny. 

Lightroom CC requires an Adobe Creative Cloud subscription to use; 
since it’s tied so closely to Creative Cloud, there’s no stand-alone 
version. Adobe offers four plans that include Lightroom CC: 

•	 Lightroom CC Plan: For $9.99 per month, you get Lightroom CC 
and 1 TB of storage. 

•	 Creative Cloud Photography Plan: Also at $9.99 per month, 
this plan includes Lightroom CC, Lightroom Classic CC, Photoshop 
CC and 20 GB of cloud storage. Increasing the storage to 1 TB costs 
$19.99 per month. 

•	 Creative Cloud All Apps: The all-everything plan at $49.99 per 
month gives you all applications and services in the Creative Cloud 
suite, including Lightroom CC and 100 GB of storage. 

•	 Lightroom Mobile: For people who want to use mobile devices 
exclusively, this $4.99 per month plan enables syncing in Light-
room for iOS and Lightroom for Android. 

In the first three cases, the iOS and Android apps are included. It’s 
possible to run the Lightroom mobile apps for free, which enables you 
to capture, store, and edit photos. However, you can’t sync them with 
any other device unless you have a Creative Cloud subscription. 
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Build Your Photo Library 
Photographers tend to focus on the visual, letting more mundane 
details like organization and storage (and sometimes even paying bills 
or remembering to eat) drift to the periphery. We want to edit and 
share our photos, not manage them. 

One of the main appeals of a tool like Lightroom CC is the capability to 
keep all of your photos in a single location—rather than in multiple 
folders and apps scattered across a hard drive–so you’ll always know 
where to find them. And since Lightroom CC synchronizes everything 
with Creative Cloud, your library is the same on all of your devices that 
run a version of Lightroom. 

Import Photos
 

The first step is to add photos to your library. (Lightroom CC also 
imports video clips, but they can only be viewed, not edited. The steps 
for importing video are the same as photos.) 

Tip: If you already use Lightroom Classic and have synced any 
collections via Creative Cloud (for viewing and editing in Lightroom 
Mobile apps), those photos show up automatically in albums the first 
time you launch Lightroom CC and sign in with your Creative Cloud 
account. See The Two-Lightroom Strategy for more information. 

To import new files: 

1. Click the Add Photos button on the left side of the screen. If you 
have more than one source connected to the computer, such as a 
camera or memory card, choose one from the Connected Devices 
list (Figure 1). 
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Figure 1: Add photos from the hard disk or connected devices. In 
this case, “Untitled” is a memory card. 

When no other devices or cards are attached, clicking the Add 
Photos button brings up the standard Open dialog. Navigate to the 
folder on your hard disk that contains your photos and click Review 
for Import. 

2.	 When the Review for Import window appears, all of the photos are 
selected by default (Figure 2). To choose just a subset of them, 
disable the Select All checkbox and click the thumbnail’s selection 
button (which adds a check mark) for the ones you want to import. 

Figure 2: Choose which photos to import. 
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Organize Your Photos 
What separates Lightroom CC (and Lightroom Classic) from a bevy of 
other photo editors is that it organizes all the photos in your library, so 
you don’t have to hunt and gather files from your desktop and load 
them into an editor such as Photoshop. 

Lightroom CC isn’t as robust at organizing as Lightroom Classic, but 
you can rate and tag photos, group them into albums, and filter which 
photos are shown based on that information. And Adobe’s new Sensei 
technology, which uses machine learning on Adobe’s servers to identify 
objects and scenes in your photos, makes it easy to locate images later, 
even if you didn’t apply keywords to them. 

In this chapter, I also go into detail about where your photos are 
stored, and how to choose a different location—say, if your library is 
larger than the capacity available on your computer’s hard disk—and 
what the implications are for doing so. 

View Your Library
 

The Lightroom CC interface is uncluttered, putting the focus on your 
photos. At the outset, images are displayed in the Photo Grid view, 
which fits them into interlocking rows (Figure 9). 

Figure 9: Change the thumbnail size in the default Photo Grid view. 

26 

Click here to buy the full 142-page “Take Control of Lightroom CC” for only $14.99!

https://www.takecontrolbooks.com/cart?add-to-cart=1232


       

           

        
           

      

            
        

             
            

           
          

            
             

    

  
             

            
             

    

From here you have a few viewing options: 

• To change the size of the thumbnails, drag the Grid Size slider. 

•	 To switch to the Square Grid view, which displays metadata infor-
mation such as star ratings and sync status, click the Square Grid 

button, or press the G key. 

In the Square Grid, moving the mouse pointer over an image reveals 
buttons to quickly assign a star rating or flag. 

•	 Click the Photo Grid button to return to the Photo Grid. Or, 
pressing the G key toggles between the Photo Grid and Square Grid 
views. 

• To change the sort order of the photos, click the Sort  button 
and choose Capture Date, Import Date, Modified Date, or Star 
Rating (Figure 10). In the same pop-up menu, you can reverse the 
order (so newest photos appear at the top or at the bottom, for 
example). 

Figure 10: Choose how the images are sorted. 

The Detail View 
The Detail view is where you get a closer look at individual photos. 
With an image selected, click the Detail button, press the D key, or 
double-click a thumbnail in one of the grid views. You can also press 
Return/Enter or the Space bar. 
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Improve Your Photos 
Sometimes you get a photo right in-camera. It’s a goal you should aim 
for, but it doesn’t always happen. 

You can be more free when photographing a scene when you know 
how to edit in Lightroom CC, whether that’s reframing the shot by 
cropping it, adjusting the lighting to be more balanced, or applying a 
filter that gives it a unique look. 

Essential Editing Basics
 

These are the foundation-level tasks you’ll perform again and again 
until they’re second nature (which happens pretty quickly): 

•	 Open the Edit panel: With a photo selected in the Grid or Detail 
views, click the Edit button, or simply press E. The Edit panel 
opens on the right (Figure 35). 

Figure 35: The Edit panel appears at the right edge of the window. 

58 

Click here to buy the full 142-page “Take Control of Lightroom CC” for only $14.99!

https://www.takecontrolbooks.com/cart?add-to-cart=1232


            
     

          
        

         
         

         
          

          
         
            

            
 

          
           

             
            

            

            
            

    

            
          

        

              
        

            
        
            

         

         
             

Click the expansion triangle to the right of an edit control’s name 
(such as Light) to reveal the specific adjustments. 

Tip: To reduce screen clutter, you can opt to view just one edit 
control at a time. Choose View > Edit Panels > Single-Panel Mode. 

•	 Undo and Redo: We probably do this more than we’re conscious-
ly aware of: choose Edit > Undo (Command-Z/Control-Z) to cancel 
the last editing action, or choose Edit > Redo (Command-Shift-Z/ 
Control-Shift-Z) to redo an action you undid. You can step back 
through an image’s edits, and Lightroom CC even keeps track of 
them on an image-by-image basis; for example, switch to another 
photo and apply some edits, then return to the previous photo, and 
the Undo and Redo commands work just on the edits to that previ-
ous image. 

•	 Reset Adjustments: If you want to set an adjustment slider back 
to its default value, click its name (which will change to append 
Reset to the front of it, as in “Reset Exposure”). Holding Option or 
Alt and clicking the category name, such as Light, lets you reset all 
of its sliders. You can also double-click a slider to reset its value. 

•	 Revert to Original: To remove all of your edits and start over, 
open the Edit panel, click the ellipsis button, and choose Revert 
to Original (or press Shift-R). 

• Show Original: Click the Show Original button, or press the \ 
(backslash) key to temporarily view the image in its unedited state. 
Click it again to return to the edited version. 

•	 Make a Copy: What if you want to see how an edited photo looks 
with a different treatment, such as black-and-white? Choose Edit > 
Make a Copy, or right-click and choose Make a Copy from the 
contextual menu. A duplicate appears. (If you’re familiar with 
Lightroom Classic, making a copy does duplicate the file on disk; it’s 
not a “virtual copy” the way Classic handles this action.) 

•	 Copy and Paste Adjustments: A powerful editing tool is the 
capability to take all the edits you made to one image and apply 
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Share Your Photos 
Lightroom CC’s options for sharing photos are pretty slim in this initial 
version. As of this writing, you can post a photo directly to Facebook or 
export an image to your hard disk. Slightly more interesting is the 
capability to make an album accessible via Lightroom for Web, includ-
ing the option to let people download the images. 

Send to Facebook
 

To post a photo to your timeline on Facebook, do the following: 

1.	 Select one or more photos in one of the Grid views, or open one in 
the Detail view. 

2. Click the Share button and choose Facebook under Send To 
(Figure 95). 

Figure 95: It’s where everybody is, anyway. 

If this is the first time you’ve sent an image to Facebook, you’ll need 
to authorize Lightroom CC to access your account. Click the Go to 
Facebook button and follow the instructions. This process also lets 
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you choose which audience (such as Public or Friends) can view 
your Lightroom photos. 

3.	 Enter a caption to appear with the image(s) (Figure 96). 

Figure 96: Write a caption and choose an optional Facebook album. 

4.	 If you want the photo(s) to appear in an album that exists in your 
account, choose it from the Post Photos To pop-up menu. 

5.	 Click Share to send the photo(s) to your timeline (Figure 97). 

Figure 97: Your lovely photos, scaled down and compressed for the 
Facebook audience. 
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Work with Lightroom 
Classic 

If you’re coming from a history of using Lightroom, think hard about 
whether you want to migrate your existing catalog(s). If you want to 
continue to take advantage of Classic features, such as merging images 
to create HDR or panorama photos, printing, identifying people by 
facial recognition, uploading to social services other than Facebook, 
creating books or web galleries, organizing by colors, or using Smart 
Albums, then my advice for now is to not migrate. 

Primarily, this is because the new Lightroom CC is still a young pro-
gram that doesn’t have all of the same features as Classic. If you use a 
lot of those Classic features, take this opportunity to kick the tires on 
Lightroom CC on the side. Migrating your existing Classic library to it 
is an extreme measure. 

On the other hand, I know people who have relatively small Classic 
libraries who use only a fraction of the application’s features. For them, 
and perhaps you, moving to Lightroom CC is the right course. 

Note: If you’re still running Lightroom CC 2015 or the standalone 
Lightroom 6, migration turns syncing off in those versions. To contin-
ue to sync with Creative Cloud, you must upgrade to Lightroom 
Classic (which is available now only via subscription). 

Migrate a Classic Catalog
 

Before you migrate a Classic Catalog, keep these important things in 
mind: 

•	 You must have enough free disk space to store an entire copy of the 
catalog you’re migrating. Lightroom CC makes a copy of every 
image during migration, so if your catalog is 2 TB in size, you need 
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at least another 2 TB free. However, that space can be on a separate 
drive; in Lightroom CC’s preferences, specify the destination for 
your originals to be stored. But using a separate drive doesn’t let 
you completely off the hook. Lightroom CC also stores a copy of the 
catalog file and Smart Previews of the photos on the startup disk, 
which could take up 20% of your startup disk during migration. 
Make sure you have room there, too. 

•	 A catalog can be migrated only once. 

•	 Lightroom CC uses only one library; you can’t have several catalogs, 
as in Lightroom Classic. However, you can migrate multiple cata-
logs to be included in your Lightroom CC library. 

•	 Collections become albums. 

•	 Smart Collections are ignored entirely. 

•	 Star ratings, flags, and keywords are retained during a migration, 
but color labels are converted to keywords (Label_yellow, Label_red, 
Label_blue, and so on). 

•	 Custom presets don’t migrate, but you can copy them from Classic 
to Lightroom CC. See Apply Presets. 

•	 After migration, all of the images sync to Creative Cloud—it could be 
a while before it’s all transferred and available in Lightroom Mobile 
and Lightroom CC on other machines. 

Prepare the Lightroom Classic Catalog 
Taking a few steps prior to migrating a catalog helps ensure you’re 
bringing clean data into Lightroom CC. 

Optimize the Catalog 
In Lightroom Classic, choose File > Optimize Catalog to have the 
application examine the data structure of the catalog file. Click the 
Optimize button to confirm the action. Depending on the size of the 
catalog, you may not be able to use Lightroom for several minutes 
while it’s working. 
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About This Book 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments. 

Ebook Extras
 

You can access extras related to this ebook on the web. Once you’re 
on the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy 
a subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

•	 Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

•	 Find out if we have any update plans for the ebook. 

If you bought this ebook from the Take Control website, it has been 
automatically added to your account, where you can download it in 
other formats and access any future updates. However, if you bought 
this ebook elsewhere, you can add it to your account manually: 

•	 If you already have a Take Control account, log in to your account, 
and then click the “access extras…” link above. 

•	 If you don’t have a Take Control account, first make one by follow-
ing the directions that appear when you click the “access extras…” 
link above. Then, once you are logged in to your new account, add 
your ebook by clicking the “access extras…” link a second time. 

Note: If you try these directions and find that your device is incom-
patible with the Take Control website, contact us.
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Copyright and Fine Print 
Take Control of Lightroom CC 
ISBN: 978-1-947282-13-1
 

Copyright © 2018, Jeff Carlson. All rights reserved.
 

alt concepts inc. 4142 Adams Ave. #103-619, San Diego CA 92116, USA 

Why Take Control? We designed Take Control electronic books to help readers regain 
a measure of control in an oftentimes out-of-control universe. With Take Control, we also 
work to streamline the publication process so that information about quickly changing 
technical topics can be published while it’s still relevant and accurate. 

Our books are DRM-free: This ebook doesn’t use digital rights management in any 
way because DRM makes life harder for everyone. So we ask a favor of our readers. If you 
want to share your copy of this ebook with a friend, please do so as you would a physical 
book, meaning that if your friend uses it regularly, they should buy a copy. Your support 
makes it possible for future Take Control ebooks to hit the internet long before you’d find 
the same information in a printed book. Plus, if you buy the ebook, you’re entitled to any 
free updates that become available. 

Remember the trees! You have our permission to make a single print copy of this 
ebook for personal use, if you must. Please reference this page if a print service refuses 
to print the ebook for copyright reasons. 

Caveat lector: Although the author and alt concepts inc. have made a reasonable effort 
to ensure the accuracy of the information herein, they assume no responsibility for errors 
or omissions. The information in this book is distributed “As Is,” without warranty of any 
kind. Neither alt concepts inc. nor the author shall be liable to any person or entity for any 
special, indirect, incidental, or consequential damages, including without limitation lost 
revenues or lost profits, that may result (or that are alleged to result) from the use of these 
materials. In other words, use this information at your own risk. 

It’s just a name: Many of the designations in this ebook used to distinguish products 
and services are claimed as trademarks or service marks. Any trademarks, service marks, 
product names, or named features that appear in this title are assumed to be the property 
of their respective owners. All product names and services are used in an editorial fashion 
only, with no intention of infringement. No such use, or the use of any trade name, is 
meant to convey endorsement or other affiliation with this title. 

We aren’t Apple: This title is an independent publication and has not been authorized, 
sponsored, or otherwise approved by Apple Inc. Because of the nature of this title, it uses 
terms that are registered trademarks or service marks of Apple Inc. If you’re into that sort 
of thing, you can view a complete list of Apple Inc.’s registered trademarks and service 
marks. 
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